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Cartoon By Greg West

ACGNJ Meetings
For the very latest news on ACGNJ meetings, please
visit the ACGNJ Website (www.acgnj.org).
Lunics (Linux/UNIX): Monday, June 3, 8:00 PM
Andreas Meyer (lunics (at) acgnj.org)
Board of Directors Meeting: Tues, Jun 4, 7:00 PM
Mike Redlich (president (at) acgnj.org)
Main Meeting: Friday, June 7. 8:00 PM
Mike Redlich (president (at) acgnj.org)
Layman’s Forum: Monday, June 10, 8:00 PM
Matt Skoda (som359 (at) aol.com)
Java: Tuesday, June 11, 7:30 PM
Mike Redlich (mike (at) redlich.net)
Mobile Devices: Wednesday, June 12, 7:30 PM
Brenda Bell (mobdevsig (at) acgnj.org)
Investing: Thursday, June 13, 8:00 PM
Jim Cooper (jim (at) thecoopers.org).

Mini-Editorial

NJ Gamers: Friday, June 14, 6:00 PM
Gregg McCarthy (greggmajestic (at) gmail.com)

Ideas Wanted!
Whether or not you are a member, we need your
ideas about how to make this newsletter better. We'll
seriously consider any suggestions that we receive.
So please send us something. Thank you.

Web Browser: Monday, June 17, 7:30 PM
David McRitchie (firefox (at) acgnj.org)
C/C++: Tuesday, June 18, 7:30 PM
Bruce Arnold (barnold (at) ieee.org)
Window Pains: Friday, June 21, 8:00 PM
John Raff (john (at) jraff.com)
All meetings, unless otherwise noted, are at the Scotch
Plains Rescue Squad, 1916 Bartle Ave, Scotch Plains,
New Jersey. Directions and map on back page.

http://www.acgnj.org
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group. Opinions expressed herein are solely
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Inc. All rights reserved. Permission to
reprint with appropriate credit is hereby
given to non-profit organizations.
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Would you pay for it?
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Nephew of “Why So Big?”
Bob Hawes, ACGNJ
At the end of Niece of “Why So Big?” (my article
for our May 2013 issue), I said; “I should perform at
least one more PDF file size comparison, this time
between a Linux/Scribus 1.3.3.13 system and a
Linux/Scribus 1.4.0 system”, and “I really should do
more TIF experiments”. In this article, I hope to
accomplish both of those goals; but why TIF? Here's
a more-or-less direct quote from the Scribus Manual;
“There are three kinds of file formats that work well
for images like photos and anything that is made up
of pixels and have been time tested: TIFF, tif and
Tiff. No matter which way you spell it, TIF is the file
format for bitmap images. Period. End of story.
Don't give me any arguments: I'll win”. Further
below, we'll see if I agree with that particular author;
but first, for your convenience, here are some recaps:
Scribus is my fun, fabulous, and free desktop
publisher. Its newer 1.4.x releases are !!!NOT!!!
backwards compatible with its earlier 1.3.x releases.
GIF (Graphics Interchange Format) files were

introduced by CompuServe in the mid eighties.
They're compact, and they use lossless data
compression; but they support only 256 colors.
Unfortunately, some transcendent genius at Scribus
has decreed that you'll get useless, intrusive and
distracting “Image is GIF” error messages any time
that you use them. JPG (or JPEG, for Joint
Photographic Experts Group) files were introduced
by the ISO (International Standards Organization),
also in the mid eighties. They're very popular for
digital photography, even though (or maybe
because) they use lossy compression.
TIF (or TIFF, for Tagged Image File Format) files
were introduced in the mid eighties as well, by the
Aldus Corporation. Originally created for desktop
scanners, they were quickly adopted by the
publishing industry in general. They support lossless
or lossy compression, as desired. PNG (Portable
Network Graphics) files employ lossless data
compression. Their specification was originally

(Continued Above Right)

(Continued Below Left)

authored via e-mail in the mid nineties, by a group
of computer graphics users who were dissatisfied
with GIF files for various reasons.
OK. Let's get down to business. Back in January, the
borrowed Vista laptop computer that I was using
while I was in the hospital (to make our October,
November and December newsletters, using the
Windows version of Scribus 1.4.1) crashed suddenly
(and very thoroughly), taking my not quite finished
January newsletter along with it. It took me two
special day-trips home (a total of 14 hours) to create
a replacement January issue from scratch on my
main Linux computer (booted from my Ubuntu
11.04 hard disk, and running Scribus 1.3.3.13). Now,
I plan to de-construct that January replacement
newsletter twice, and then re-construct it several
times more. For consistency, I'll start with
Scribus1.4.0. This will allow me to follow the
precedents established in Why So Big? (December
2012). Son of “Why So Big?” (January 2013).
Daughter of “Why So Big?” (February 2013). and
Niece of “Why So Big?” (May 2013).

But first, just a little bit more recap: As inferred
above, to get a system running Scribus 1.3.3.13 (my
preferred version), I currently have to boot my
computer from my way out of date Ubuntu 11.04
hard disk. However, in Revenge of the 13 Things
(my article in our April 2013 issue), I described how
I upgraded my hardly-ever-used Ubuntu 11.10 hard
disk to version 12.04 LTS. (As a Long Term Support
release, it still has two more years to go before it
expires). If I'd used that 11.10 disk more often, I
might have noticed that Scribus 1.4.0 had been
automatically installed when it was created. As a
result, my new 12.04 system also has 1.4.0. I'll try to
back-grade (downgrade?) this version of Scribus
eventually, but for now, I've got it, so I'll use it.
One more digression, (but that's it. I promise). I don't
know if I've ever sufficiently explained the
difference in the way Scribus treats text files and
image files. When I right-click on an empty text
frame, and then choose “Get Text”, Scribus actually
does copy that text into its work file; but when I
right-click on an empty image frame, and choose
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Nephew of “Why So Big?”, continued
“Get Image”, Scribus doesn't really copy that image.
It just copies that file's name and location into its
work file. While it's true that the image seems to
appear in that image frame, it is, in fact just a
preview picture, like a thumbnail. Only when I
choose “File > Export > Save as PDF” does Scribus
actually copy any of its images into its output PDF
file; and only as it actually creates that PDF. So
below, when I say that I'm deleting an image from a
Scribus work file, I'm really only deleting that
image's file name.
So now let's really get down to business. The Scribus
work file for our January issue was named
2013Jan7.sla. Leaving the original file untouched, I
made two copies of it, and renamed them 2013Jan73.sla and 2013Jan7-4.sla. (3 for Scribus 1.3.3.13 and
4 for Scribus 1.4.0). Opening the 4 version, I
immediately made a PDF from it, just as it was. It
measured 3.2 MB. Going to page 16, I deleted that
page's one and only image, the 414 KB file
1108page16-150.png. I got a PDF measuring 2.5
MB. A 0.7 MB decrease. (Actually 707.2 KB). Then,

going to page 15, I deleted its one and only image,
the 308 KB file 1108page15-150.png. I got a PDF
measuring 2.0 MB. A 0.5 MB decrease. (Actually
480.7 KB).
On page 14, I deleted its largest file first, the 2.5 MB
file NL_CD_12.png, and got a PDF measuring 1.4
MB. That would seem to yield a decrease of 0.6 MB;
but that's due to inaccuracies when the MB figures
were “rounded off”. It's actually a true difference of
512 KB. The seven remaining images on page 14,
and the six images on page 13 were all copies of the
same image, the 7.5 KB file TINY_PC2.gif. (The
teeny tiny computer pictures that we use to mark the
ends of various closing paragraphs). Deleting them
gave me an output PDF measuring 1.4 MB. That
would seem to indicate a decrease of zero MB; but
that's another “rounding” inaccuracy. It's actually a
true difference of 38 bytes. (That's because I hadn't
really deleted any images, only links to an as-yet
undeleted image elsewhere in the PDF).
On page 12, the sole image was a 31 KB file named
PC-3line.png. Deleting it gave me a 63 KB decrease

(Continued Above Right)

(Continued Below Left)

in PDF size. There were no images on page 11. On
page 10, the sole image was a a 6.2 KB file named
PC-SeeYa.png. Deleting it gave me an 11 KB
decrease in PDF size. There were also no images on
pages 9 through 2, so that brings us to page 1. Its
first image was the one undeleted copy of the 7.5 KB
file TINY_PC2.gif. Deleting it gave me a 27.4 KB
decrease in PDF size. The second (and last) image
on page 1 was the 64.1 KB file ACGNJ3RC.PNG.
Deleting it gave me a 258 KB decrease in output file
size, for a final PDF measuring 1.1 MB.
Except for that surprisingly large final decrease,
everything seemed to parallel my earlier articles. (At
least as far as sizes went). So I shut down my
computer and switched to my Ubuntu 11.04 hard
disk (to get Scribus 1.3.3.13). I opened 2013Jan73.sla, my previously prepared extra copy of the
January work file. As before, I immediately made a
PDF from it, just as it was. It measured 2.2 MB.
Here we hit our first difference. Remember, the
initial PDF made by 1.4.0 (just three paragraphs
above) measured 3.2 MB. Right up front, it seems

that a PDF made by 1.3.3.13 will come out about 1
MB smaller than a PDF made by 1.4.0. Will this
trend hold?
Going to page 16 as before, I deleted its one and
only image, the 414 KB file 1108page16-150.png;
and I got a PDF measuring 1.9 MB. A 0.3 MB
decrease. (Actually 293.8 KB). Then, going to page
15, I deleted its one and only image, the 308 KB file
1108page15-150.png; and I got a PDF measuring 1.7
MB. A 0.2 MB decrease. (Actually 257 KB). On
page 14, I deleted NL_CD_12.png first. (The largest
file, remember, measuring 2.5 MB); and I got a PDF
measuring 1.2 MB. A 0.5 MB decrease. (Actually
509 KB. Close).
As before, the seven remaining images on page 14,
and the six images on page 13 were all copies of the
7.5 KB file TINY_PC2.gif. Deleting them gave me
an output PDF measuring 1.2 MB. (For a true
difference of 44 bytes. Pretty close to the 38 bytes
above, but not smaller, as I'd expected). As above,
the lone image on page 12 was the 31 KB file PC3line.png. Deleting it gave me a 27.3 KB decrease in
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Nephew of “Why So Big?”, continued
PDF size. There were no images on page 11. On
page 10, the lone image was the 6.2 KB file PCSeeYa.png. Deleting it gave me a 6.6 KB decrease in
PDF size.
As expected, there were no images, lone, riding
again, or otherwise, on pages 9 through 2, so that
brings us to page 1. Its first image was the one
undeleted copy of the 7.5 KB file TINY_PC2.gif.
Deleting it gave me a 6.8 KB decrease in PDF size.
The second (and last) image on page 1 was the 64.1
KB file ACGNJ3RC.PNG. Deleting it gave me a mere
94.3 KB decrease in output file size (compared to
258 KB above), for a final output PDF that also
measured 1.1 MB. (In fact, there was only a 44.4 KB
difference between the two, with the previous 1.4.0
result winding up smaller than this most recent
1.3.3.13 result. Not at all what I'd expected).
That unforeseen and oh-so-close result made me
change some of my plans for the rest of this article;
but my first two steps remained the same. I made a
copy of each of my two now image-less Scribus
work files (2013Jan7-3.sla and 2013Jan7-4.sla) and

renamed them 2013Jan7-3-O.sla and 2013Jan7-4O.sla. (O for “Original”). These will be saved as justin-case emergency backups. Next, as planned, I
made two more copies of my 1.4.0 work file
(2013Jan7-4.sla), one for adding JPG files, and one
for adding TIF files; but I changed their proposed
names slightly, to 2013Jan7-44J.sla and 2013Jan744T.sla. (The 44 means deconstructed by 1.4.0, and
then reconstructed by 1.4.0. The J means using only
JPG files, while the T means using only TIF files).
Then, I made four more copies of my 1.3.3.13 work
file (2013Jan7-3.sla); and renamed them 2013Jan733J.sla, 2013Jan7-33T.sla, 2013Jan7-34J.sla and
2013Jan7-34T.sla. (33 means a “pure” version:
deconstructed by 1.3.3.13, and then also
reconstructed by 1.3.3.13, while 34 signifies a
“hybrid” version: deconstructed by 1.3.3.13, then
reconstructed by 1.4.0. As before, J means using
only JPG files, and T means using only TIF files).
While I fully expect my “hybrid 34” and “pure 44”
results to come out very close to equal for their
respective file formats, I feel that I should test each

(Continued Above Right)

(Continued Below Left)

of them at least once, just to be sure.
However, we'll do Scribus 1.3.3.13 first. Starting
with 2013Jan7-33J.sla, I went to page 1. Its first
image was the newly converted 134.3 KB file
ACGNJ3RC.JPG. Adding it gave me an increase of
136.8 KB. Adding page 1's second image, the
recently converted 14.7 KB file TINY_PC2.jpg, gave
me an increase of 15.3 KB. On page 10, the only
image was the 6.2 KB file PC-SeeYa.jpg. Adding it
gave me a 6.6 KB increase in PDF size. As above,
the sole image on page 12 was the 38.5 KB file PC3line.jpg. Adding it gave me a 39.7 KB increase in
PDF size.
As before, the six images on page 13 and seven of
the eight images on page 14 were all copies of the
14.7 KB file TINY_PC2.jpg. As expected, adding
them gave me a difference of only 75 bytes. The
remaining image on page 14 was the 253.8 KB file
NL_CD_12.jpg. Adding it gave me a 260 KB
increase. Going to page 15, I added its one and only
image, 1108page15-150.jpg, (a 302.7 KB file) and I
got a 310 KB increase. Then, on page 16, I added its

one and only image, the 449.9 KB file 1108page16150.jpg; and I got a 461 KB increase, for a final PDF
measuring 2.2 MB.
All in all, a big disappointment. Remember that
when we started our calculations (eleven paragraphs
above), the initial PDF made by 1.4.0 measured 3.2
MB, while the initial PDF made by 1.3.3.13 came in
at 2.2 MB. Here, we went to all that work, changed
all our files to the JPG format, and our result for
1.3.3.13 turned out to be the same. Oh, well. Let's
soldier on, and see what we get for TIF files. As an
aside: Twenty-three years ago, when I got my first
PC, I used TIF files a whole lot. In the last fifteen
years or so, not all that much. Was I right or wrong
to switch? Maybe we'll soon find out.
Otherwise sticking with Scribus 1.3.3.13, I opened
2013Jan7-33T.sla and went to its page 1. The first
image was the 113.1 KB file ACGNJ3RC.TIF.
Adding it gave me an increase of 98.5 KB. Adding
page 1's second image, the 194.2 KB file
TINY_PC2.tif, gave me an increase of 7.3 KB. On
page 10, the only image was the 50.7 KB file PC-
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Nephew of “Why So Big?”, continued
SeeYa.tif. Adding it gave me a 5.1 KB increase in
PDF size. As above, the sole image on page 12 was
the 53.8 KB file PC-3line.tif. Adding it gave me a
27.6 KB increase in PDF size.
As before, the six images on page 13 and seven of
the eight images on page 14 were all copies of the
194.2 KB file TINY_PC2.tif. As expected, adding
them gave me a difference of only 75 bytes. The
remaining image on page 14 was the 2.7 MB file
NL_CD_12.tif. Adding it gave me a 512 KB
increase. Going to page 15, I added its one and only
image, 1108page15-150.tif, (a 498.4 KB file) and I
got a 259 KB increase. Then, on page 16, I added its
one and only image, the 690.6 KB file 1108page16150.tif; and I got a 302 KB increase, for a final PDF

measuring 2.2 MB.
At this point, we've completed all the 1.3.3.13 tests
that I intended to do for this article. Normally, I'd
proceed to my planned 1.4.0 tests; but as Monty
Python used to say; “My brain hurts”. Anyway, 2.2
MB = 2.2 MB = 2.2 MB. Right? Well, not exactly.
Translated into KB, that initial 2.2 MB figure equals
2,311 KB, the TIF figure equals 2,314 KB, and the
JPG figure equals 2,332 KB. So, in actual fact, the
initial file combination wins, the exclusively TIF
arrangement comes in a very close second, and the
JPG files come in an almost-as-close third. However,
my brain still hurts. It needs a rest. So:

Extending the Life of Your XP PC
Dick Maybach, Brookdale Computer Users’ Group, NJ
Newsletter: BUG Bytes (www.bcug.com) n2nd (at) charter.net
When you first got your PC with Windows XP it was
blazingly fast and its hard disk was huge. But now,

maybe 10 years later, it has slowed, perhaps
drastically so, and its disk is nearly full. The cause of

(Continued Above Right)

(Continued Below Left)

the disk-space shortage is probably obvious, you've
stored thousands of photos, songs, and documents,
and installed many programs. But what about the
speed? Unlike you and I, electronic hardware doesn't
slow down as it ages.
Hopefully, you've kept your software, especially
your anti-virus program, up to date and have avoided
downloading files from questionable sources. If not
(or if someone who uses your PC is less careful), run
a full virus and malware check and update Windows
and all your applications before you try anything else.
At the time you bought your XP PC, 500 Mbytes of
RAM was plenty, but the patches and enhancements
you've added over the ensuing years means that the
XP you now use is much different than the XP you
originally bought. In particular, 500 Mbytes of RAM
is now woefully inadequate. To check your RAM
use, simultaneously press the Control, Alt, and
Delete keys, select the Task Manager button on the
Window that pops up, and then select the
Performance tab.
I did this on my laptop and found that with no

applications running except for my virus checker, it
was using about 814 Mbytes of RAM. Fortunately,
this PC has 1 Gbyte of RAM, and its memory limit
is nearly 2 Gbyte. The second Gbyte is provided by
the swap file; when Windows needs more memory
than you have physical RAM, it moves some data
from RAM to a swap file on your hard disk to make
room. If this happens more than occasionally, the
situation is called thrashing, which results in
Windows slowing to a crawl as it continually moves
data from RAM to disk and back again. If your XP
PC has only 500 Mbytes of RAM, it will begin
thrashing as it boots, and will be frustratingly slow.
The only fix for this is to increase RAM to at least 1
Gbyte. Removing programs, defragging, and other
such measures will not improve the situation at all,
despite what fraudulent TV ads say.
Instead of adding RAM, you could switch to Linux,
although for an old PC you will have to use a
lightweight distribution, such as Xubuntu.
(Mainstream Linux distributions, such as Ubuntu,
require modern display controllers.) The only
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Extending the Life of Your XP PC, continued
difference between these and the mainstream
cousins, such as Ubuntu, is that the displays are
simpler; that is, you lose some of the visual bling
that the software vendors think you want; both types
support all the same applications. On the same
laptop as above, Xubuntu used only 210 Mbytes of
RAM, compared to XP's 814 Mbytes. Linux thus
provides a way to extend the useful life of old PCs
by many years. This approach is especially attractive
for laptops, whose hardware is difficult to upgrade.
If you want to keep using XP, you have little choice
but to increase the amount of its RAM. Beyond this
there are other steps you can take, although their
effects on performance will be much smaller. Before
you do any of the following, back up your entire PC.
If you haven't already, use your favorite anti-virus
software to get rid of any malware, use Microsoft
Update to bring the system up to date, and update the
drivers. Then look at the installed programs with the
sequence Start ® Control Panel ® Add or Remove
Programs. Highlight each in turn to see how much
disk space it occupies, how often you use it, and the

date you used it last. Ask yourself if you really need
it, and if not click the Remove button to remove it.
This will free disk space and may speed up your PC
if the program has a module that resides in RAM.
On my laptop, I haven't used Adobe Reader for over
five years, and I could recover 86 Mbytes of disk
space by removing it.
You can clean up a drive with the following
sequence: Double-click on Computer ® right-click
on the desired drive ® select Properties ® click on
the Disk Cleanup button.
On my laptop, I could recover almost 22 Mbytes of
disk space by deleting Downloaded Program Files,
Temporary Internet Files, Offline Webpages and
Temporary files. (And I could recover almost an
additional 3.7 Gbytes by compressing old files,
which I prefer not to do.)
You may gain some speed by disabling some of the
visual display effects. Navigate Start ® Control
Panel ® System ® Advanced tab ® in the
Performance box click on Settings and uncheck
everything except:

(Continued Above Right)
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Show shadows under menus,
Show shadows under mouse pointer,
Show translucent selection rectangle,
Smooth edges of screen fonts,
Use drop shadows for icons labels on the desktop,
and
Use visual styles on windows and buttons.
The following will recover an impressive amount of
disk space, but do it only if you have a recent backup that you know to be good. Move to the directory
C:\Windows and make the hidden items visible by
clicking on Tools (in the menu bar), selecting Folder
Options, selecting the View tab, and the selecting the
Show hidden files and folders item. You will find a
large number of directories whose names begin and
end with $ and include “Uninstall” somewhere in
between. These allow you to back out of patches, but
it is most unlikely you will ever have to do this,
especially if your system is running well. (My laptop
had 339 such folders, occupying over 250 Mbytes.)
You can delete them and recover the space, but be
very careful not to delete anything else, in particular,

directories whose names begin and end with $ but
don't include “Uninstall”. It would be prudent not to
empty the Recycle Bin for a few days, until you're
sure you haven't broken anything.
CCleaner (http://www.piriform.com/CCLEANER) is
a clean-up tool with a good reputation. It takes a
more aggressive approach than does the disk cleanup
procedure discussed above. There is a free version,
but read the installer screens carefully as it will
install a Google toolbar unless you uncheck the
appropriate box. The first time you run the program,
click on the Analyze button to see what it will do;
the screen-shot below shows the effect on my laptop.
(I had earlier performed the Windows Disk Cleanup
described above.)
It claimed to find almost an additional 83 Mbytes of
disk space that could be freed, although it removed
only about 80 Mbytes. The program also includes
tools to clean up the registry, uninstall programs,
manage system restore points, and wipe disk drives,
and will also show what programs run at startup. For
more information see http://www.howtogeek.com/
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Extending the Life of Your XP PC, continued
113382/how-to-use-ccleaner-like-a-pro-9-tips-tricks/.
Finally, a different company has developed an add-on,
CCEnhancer (http://singularlabs.com/software/ccenha
ncer/). On my laptop, this add-on allowed CCleaner to
find 10.7 Mbytes of additional files. However,
CCEnhancer requires .NET 3.5, which uses several
hundred Mbytes; if you don't already
have this installed, forget about
CCEnhancer as what it can recover is
only a small fraction of the space
.NET will occupy.
I haven't mentioned defragging
because I've never found that it
improves performance by any
detectable amount. I'm not saying it's
a bad idea, just that you shouldn't
expect any performance change.
Also consider a hardware approach to
increasing disk space. In particular,
USB hard disks are inexpensive and
easily installed on both desktops and
laptops, and although they are much
slower than internal hard drives, they

are entirely satisfactory for storing data that you
don't access frequently.

Get creative with Text Boxes
Nancy DeMarte, Regular Columnist (Office Talk), Sarasota PCUG, Florida
Newsletter: PC Monitor (www.spcug.org) ndemarte (at) Verizon.net
When you use Microsoft Office, you create and edit
text all the time. Word, of course, is dominated by
text; Excel and PowerPoint both use text in many of
their functions. All recent versions of Office also
include a tool called a “text box” for special uses of
text. Let’s find out what it is and how to use it.
A text box is a specialized shape in which you can
enter text. It functions outside the regular margin
constraints of a document and can be moved or
resized as needed. A text box is useful for adding a
caption to a photo or annotating a diagram or chart.
If you want to emphasize an important statement in a
document, you can use a text box to repeat the
statement in a “pull quote” and locate it in an
unexpected spot, such as along a margin (known as a
Sidebar) or across columns in the document. Its
flexibility makes a text box useful in many situations.
Page 8

Text boxes have most of the same properties as
shapes. In Word 2007 and 2010, when you click the
Insert tab, then Text Box, you open the Text Box
gallery of 36 preformatted text boxes, as well as the
“Draw text box” option. If one of the preset boxes
meets your needs, click to insert it into the
document. Older versions of Word lack this gallery,
but you can still draw a text box, which is most often
my choice. Click “Draw text box” at the bottom of
the gallery. Then click anywhere in your document
where you want the text box to appear and drag
diagonally down the page to the right to create the
text box. At first the box covers a portion of the
normal text. This is because the default text
wrapping setting is “in front of text.” If you don’t
want the text box to hide the document text, select
the text box so “handles” appear around the box. At

ACGNJ

June 2013

Get creative with Text Boxes, continued
this point, the Text Box Tools Format tab appears on
the ribbon. Click Format, and then Text Wrapping in
the Arrange group. Change the setting to Tight,
which will position the text box within the existing
text and also allow you to move the text box. Do this
by clicking an edge so a crossed arrows icon appears
and dragging it to a new location. You can also resize
the box by dragging an edge or corner. To enter text
in the box, replace the informational text with your
own.
Once a text box is created and located in the
document, it can be formatted in many ways. To
format the text, select it, and a small version of the
Font group on the Home tab will appear. Use these
tools to change the font style, size, color, and other
attributes. (You can also click the Home tab and use
the full set of options in the Font group.) To format
the text box itself, select it and use the tools on the
Text Box Tools Format tab. For example, you can fill
the box with a color, remove or change the border
styles, make the text read vertically, or add special 3D effects.

In Office 2007 and 2010, text boxes are not limited
to a rectangular shape. You can add text to any of the
items in the shapes gallery. Click Insert – Shapes and
click a shape. Click in your document and draw the
shape in the same way you drew the text box.
Change the text wrapping to Tight as you did above,
then right click inside the shape and choose “Add
Text.” The large number of shape choices gives you
many options for text boxes. Another approach is to
begin with a classic text box, even after it is filled
with text. Select it, which opens the Text Box Tools
Format tab. Click Format and select “Change
shape,” which opens the shapes gallery. Click a new
shape, and the text box transforms into that shape
with all its contents intact. Another interesting
possibility is inserting a photo or piece of clip art
into a text box. With the text box or shape selected,
click the Insert tab – Picture. Click the photo you
want, then Insert. The photo appears in the text box,
resized to fit. The same steps work to insert clip art,
charts or tables within text boxes.
Text boxes can be rotated for a dramatic effect. In

(Continued Above Right)

(Continued Below Left)

Office 2010, select the text box, and click and drag
the little green rotator circle above the box to rotate
it left or right. In Word 2007, for an unknown reason,
classic text boxes cannot be rotated, even though
shapes can. One way to work around this problem is
to create a text box, cut it using the Cut command on
the Home tab, and then paste it as a “Picture
(Windows Metafile)” using the Paste Special
command option under the Paste icon.
Occasionally, you might create a text box in Word
that you’d like to reuse at a later time. You can save
it by selecting the text inside the box and then
clicking Insert and the arrow under the Text Box
icon. Choose “Save Selection to Text Box Gallery.”

Besides Word, text boxes appear in Excel and
PowerPoint 2007/10. Neither program contains a
text box gallery, but each has the “Draw a Text Box”
tool, which gives you all the functions that Word
does, including rotation. You can also start with a
shape and include text by right clicking and using
the “Edit Text” command.
Have a little fun. Create a few text boxes in your
next document, spreadsheet or presentation.

Using the Social Security Death Records
Bill Ellis, Member, Computer Users of Erie, PA
(www.cuerie.com) willardellis8 (at) gmail.com
The Social Security Administration's Death Index
(SSDI) can be a boon to beginning genealogists. The
Social Security number is the most valuable piece of
June 2013

information when seeking a number of other
documents. It is essential for ordering paper copies
of original death records, obituaries, and more. The
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Using the Social Security Death Records, continued
SSDI is the first step in obtaining this information. If
you can only trace your U.S. ancestry back to your
grandparents or possibly great-grandparents, the
Social Security Administration can help you find
where they were born, the names of their parents,
and more. The SSDI can be especially helpful for
those researching immigrants as the data often shows
where the individual was born in "the old country."
The Social Security Administration was created by
an act of law in 1935 as part of President Roosevelt's
New Deal program. The act laid out a retirement
system for many Americans, although not all. The
act also created a new governmental agency to
manage the program. In the following 69 years, the
Social Security Administration has become one of
the largest agencies in the federal government.
The Social Security Administration started
computerizing records in 1962. This made it possible
to produce an index of people who had Social
Security numbers and are deceased. The information
in the Social Security Death Index for people who
died prior to 1962 is sketchy since SSA's death

information was not automated before that date.
Persons who died before 1962 are rarely listed in the
SSDI. Some of the online Web sites advertise that
the data they possess will contain information about
deaths "as early as 1937," but that claim is a bit
misleading; 99.9% of the information is for 1962 and
later.
Initially, the Social Security Administration only
recorded the deaths of individuals who were
receiving
retirement
benefits
from
the
Administration. Those who died before reaching
retirement age were not listed. Neither were those
who had different retirement systems, such as
railroad workers, school teachers, and other
municipal, state, and federal employees. In the 1970s
the railroad and many other retirement systems were
merged into the Social Security system. Deaths of
those retirees then started appearing in the SSDI.
In the late 1980s and after, all deaths in the U.S.
were reported to the Social Security Administration
and recorded in the SSDI. You can find deaths of
children and non-retired adults listed for the 1990s,

(Continued Above Right)

(Continued Below Left)

but not for earlier years.
Because legal aliens in the U.S. can obtain a Social
Security card, their names may appear in the SSDI if
their deaths were reported, even if the death occurred
overseas.
The online SSDI databases contain the following
information fields:
Social Security number
Surname
Given Name
Date of Death
Date of Birth
Last Known Residence
Location of Last Benefit
Date and Place of Issuance
You can access the Social Security Death Index at no
charge on a number of Web sites, including:
New England Historic Genealogical Society (this
database was updated just a few weeks ago with the
latest data through June, 2004) http://www.newengla
ndancestors.org/research/database/ss/default.asp

Family Tree Legends (this version has several search
capabilities
not
found
on
other
sites):
http://www.familytreelegends.com/records/ssdi
Ancestry.com:
http://www.ancestry.com/search/rectype/vital/ssdi/ma
in.htm
The Church of Jesus Christ of Latter-day Saints (the
Mormons) offer the Social Security Death Index on
their popular Family Search site.
Keep in mind, however, that the online SSDI
database is only an index -- an abbreviated listing.
The Social Security Administration holds additional
information that can be a genealogical jackpot. The
index listing of an ancestor is merely your ticket to
this jackpot.
From 1936 on, anyone who has applied for a Social
Security Card filled out an application form (SS-5)
that the U.S. Government keeps on file. This
application form (SS-5) contains the following
information:
Full name
(Continued On Nex Page)
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Using the Social Security Death Records, continued
*Full name at birth (including maiden name)
anyone who requests information on a deceased
*Present mailing address
individual. You can obtain a photocopy of the SS-5
Age at last birthday
form by writing to the Social Security
Date of birth
Administration.
*Place of birth (city, county, state)
The SSA charges $27.00 for each individual SS-5
*Father's full name "regardless of whether living or copy ($16 for an abbreviated NUMIDENT form, but
dead"
most genealogists will prefer the SS-5 itself). The
*Mother's full name, including maiden name, SSA is not in the business of doing genealogical
"regardless of whether living or dead"
research and cannot, by law, expend Social Security
*Sex and race
Trust Fund money for purposes not related to the
*Ever applied for SS number/Railroad Retirement operation of the Social Security program. The $27
before? Yes/No
fee is intended to offset the cost to the government
*Current employer's name and address
whenever SSA provides information from its files
*Date signed
for non-program purposes.
*Applicant's signature
There is no standard form to fill out when requesting
The items marked with an asterisk are not available a copy of the deceased's SS-5. Instead, you must
in the online SSDI database.
write a letter. You can "copy-and-paste" the
The SS-5 form is obviously much more valuable to following sample letter into your favorite word
the genealogist than the limited information shown processor, then change all the information shown
in the online death index. The Social Security inside the curly braces { }:
Administration makes copies of the original Social Social Security Administration
Security application form (the SS-5) available to Office of Earnings Operations
(Continued Above Right)

(Continued Below Left)

FOIA Workgroup
300 N. Greene Street
P.O. Box 33022
Baltimore, Maryland 21290
Re: Freedom of Information Act Request
Dear Freedom of Information Officer,
I am writing this request under the Freedom of
Information Act, 5 U.S.C. Section 552. I hereby
request a copy of the SS-5, Application for Social
Security Card for the following individual:
{first name} {last name}
{Social Security Number as obtained from the online
SSDI}
Birth: {Date of birth}
Death: {Date of death}
This individual is deceased, having been listed in the
Social Security Administration's Death Master File. I
am requesting a copy of this person's original SS-5
form. I understand the fee for this service is $27.00.
Included is a check for $27.00 made out to the Social
Security Administration to cover any administrative
costs required by this request.

Please respond to my request upon receipt of this
initial correspondence. Thank you for your attention
and assistance.
Sincerely,
{Your name}
{Your full address}
Daytime Phone Number: {Your telephone number}
If you want to obtain the SS-5 forms for more than
one person, it is suggested that you write separate
letters and separate checks, and mail them in
separate envelopes. Be patient. You may have to wait
several months for the response to your letter(s).
If you cannot find a person in the SSDI, the Social
Security Administration may still be able to help.
You may request an "SSN search." The SS will try to
find the person's Social Security Number, even for
those deaths before 1962. To request this service,
you must send $29 and provide the person’s full
name, state of birth, and date of birth to:
Social Security Administration
OEO FOIA Workgroup
300 N. Green Street
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Using the Social Security Death Records, continued
P.O. Box 33022
Baltimore, Maryland 21290-3022
Providing names of parents is also helpful, especially
with common surnames. Be sure also to provide
proof of death as the records of living individuals are
not publicly available.
Social Security Numbers
It is interesting to note that you can tell where a
Social Security Number was issued simply by
looking at the first few digits of the number. This
does not tell where the person was born, only where
he or she was living when the number was issued.
Nonetheless, it can be a valuable clue as to where to
look for additional information.
The Social Security Account Number (SSAN) is
divided into three sets of digits. For example, let’s
take 123-45-6789. The 3 digits in the first group
indicate the state or territory in which the number
was originally issued. The second group of 2
numbers is used to define the people within the state.
The third group of 4 digits is simply issued in

numerical sequence.
The following list shows the area indicated by first 3
digits:
001-003 New Hampshire
004-007 Maine
008-009 Vermont
010-034 Massachusetts
035-039 Rhode Island
040-049 Connecticut
050-134 New York
135-158 New Jersey
159-211 Pennsylvania
212-220 Maryland
221-222 Delaware
223-231 Virginia
232-236 West Virginia
237-246 North Carolina
247-251 South Carolina
252-260 Georgia
261-267 Florida
268-302 Ohio
303-317 Indiana

(Continued Above Right)

(Continued Below Left)

318-361 Illinois
362-386 Michigan
387-399 Wisconsin
400-407 Kentucky
408-415 Tennessee
416-424 Alabama
425-428 Mississippi
429-432 Arkansas
433-439 Louisiana
440-448 Oklahoma
449-467 Texas
468-477 Minnesota
478-485 Iowa
486-500 Missouri
501-502 North Dakota
503-504 South Dakota
505-508 Nebraska
509-515 Kansas
516-519 Idaho
520 Wyoming
521-524 Colorado
525 New Mexico (also 585 below)
526-527 Arizona
Page 12

528-529 Utah
530 Nevada
531-539 Washington
540-544 Oregon
545-573 California
574 Alaska
575-576 Hawaii
577-579 District of Columbia
580 U.S. Virgin Islands
581-585 Puerto Rico, Guam, American Samoa
585 New Mexico (some 585 numbers)
586-699 Unassigned
700-729 Railroad Retirement Board
730-899 Unassigned
A few Social Security Numbers beginning with a 9
have been issued, but these are very rare.
For more information about obtaining information
from the Social Security Administration, look at:
http://www.socialsecurity.gov/foia/foia_guide.htm
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SIG News
LUNICS (Linux/Unix)
Andreas Meyer (lunics@acgnj.org)
http://www.acgnj.org/groups/lunics.html

Java
Mike Redlich (mike@redlich.net)
http://www.redlich.net/javasig/javasig.html

LUNICS is a group for those who share an interest in
Unix and similar operating systems. While we do
quite a bit with Linux, we’ve also been known to
discuss Solaris and BSD as well. Recent meetings
have followed a Random Access format. See our
web page for further information. (We meet on the
first Monday of each month, at 8:00 PM).

This SIG covers beginner, intermediate, and
advanced level Java programming. Primary focus is
on developing useful/practical applets and
applications. (We meet on the second Tuesday of
each month, at 7:30 PM).

Main Meeting
Evan Williams (president@acgnj.org)
http://www.acgnj.org/groups/mainmeet.html
We meet on the first Friday of the month, at 8:00
PM. Each December, this meeting includes our
Annual Business Meeting and Officer Elections. No
meetings in July or August.
Layman’s Forum
Matt Skoda (som359@aol.com)
http://www.acgnj.org/groups/laymans.html
This SIG discusses issues of interest to novice users
or those planning to get started in computing. Watch
our Web page for updates and announcements. We
meet at the same time as the Hardware Workshop.
(On the second Monday of the month, at 8:00 PM).
No meetings in July and August.
Hardware Workshop
Mike Reagan (hardware@acgnj.org)
This group is dedicated to repairing, refurbishing
and/or recycling older computers. Ten people
attended the first meeting, so there is still a market
for this type of event. Although we looked at some
of the older equipment stored in he back room, most
of our time was spent in talking about ast
experiences and planning for the future. Hopefully,
we can establish a viable long-term schedule of
projects, and keep the interest of those who attended
this inaugural meeting. If you have a hardware
problem, bring it in and we can all help fix or
demolish it. (No guarantees either way.) We meet at
the same time as the Layman's Forum. (On the
second Monday of each month, at 8:00 PM).
June 2013

Mobile Devices
Brenda Bell (mobdevsig@acgnj.org)
The Mobile Devices SIG focuses largely on currentgeneration cellphones and smart phones (such as
Blackberry, Android, iPhone) which bridge the gap
between basic cell phones and traditional computers,
and how they can help you manage and organize
your life. Our membership ranges from those who
have recently acquired their first, basic cellphone to
those who develop applications for today’s modern
smart phones, iPods, and ultra-portable computers.
While we expect to spend much of our time
investigating the built-in features and specialized
applications available to modern smart phones, if
you bring your basic (or multimedia) cell phone,
iPod, or other mobile device with questions on how
to use it, where to find applications, or what features
they have, we are always happy to help! Meet and
greet and plan where this event goes. Bring all your
ideas, PDAs, fancy phones, etc. (We meet on the
second Wednesday of alternate months (we get the
even ones), at 7:30PM).
WebDev
Evan Williams (webdev@acgnj.org)
This SIG is an open forum for all Website
Development techniques and technologies, to
encourage study and development of web sites of all
kinds. All languages will be considered and
examined. The current project is a CMS for the club.
Anyone interested in starting a new project, come to
the meeting and announce/explain. Provide as much
detail as possible. WebDev should be an allencompasing development and examination forum
for all issues, applications, OS, languages and
systems one can use to build Websites. We currently
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SIG News, continued
have two web development language SIGs: .NET
and Java; but other languages and OS need to be
investigated, examined and tested; Windows, Linux,
UNIX, DEC, Vax, HP etc. Intel-PC, Motorola MAC etc. (We meet on the second Wednesday of
alternate months (we get the odd ones), at 7:30 PM).
Investment Software
Jim Cooper (jim@thecoopers.org)
http://www.acgnj.org/groups/sig_investment.html
The Investment SIG continues with presentations on
how to use analysis programs TC2000 and TCNet.
Large charts are presented on our pull down screen
and illustrate the application of computer scans and
formulas to find stocks for profitable investments.
Technical analysis determines buy points, sell points
and projected moves. Technical analysis can also be
used on fundamentals such as earnings, sales growth,
etc. We're no longer focusing on just Telechart. If
you are using (or interested in) Tradestation, eSignal,
VectorVest, or just in learning how to select and use
charting and technical analysis, come join us!! (We
meet on the second Thursday of the month, at 8 PM).

C/C++ Programming
Bruce Arnold (barnold@ieee.org)
http://acgnj.barnold.us/index.html
This is a forum for discussion of programming in
general, beginning and intermediate level C, C++, CWin programming, hardware, algorithms, and
operating
systems.
We
demonstrate
real
programming in a non-intimidating way, presenting
complete code for working programs in 3-5 sheets of
paper. (We meet on the third Tuesday of each month,
at 7:30 PM). No meetings in July or August.
Window Pains
John Raff (jraff@comcast.net)
http://www.acgnj.org/groups/winpains.html
Intended to provide members with Windows oriented
discussions, Microsoft and Linux style. Directed to
more technological level of attendee, but newbies are
welcomed. (We meet on the third Friday of the
month at 8:00 PM). No meetings in July or August.
37th Anniversary Newsletter CD Now On Sale

NJ Gamers
Gregg McCarthy (greggmajestic@gmail.com)
http://www.NJGamers.com
www.lanparty.com

Beta .12 Release.
$8.00, including
postage.

The Friday Night Frag starts at 6:00 PM on the
second Friday of each month, and keeps going until
12 Noon on Saturday - 18 hours for 5 bucks!
BYOC - Bring your own computer.
BYOF - Bring your own food.
And if you don't like sitting on metal folding chairs...
BYO chair!

Get yours today!

Back Issues Still Needed

Web Browser (Formerly Firefox)
David McRitchie (firefox@acgnj.org).
This SIG is an open forum for all Firefox and
Mozilla techniques and technologies, to encourage
study and development of web sites of all kinds. All
browsers will be considered and examined. All
members and guests are invited to check out the
design concepts and voice their opinion. (We meet
on the third Monday of each month, at 7:30 PM).
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($7.00 if you
pick up a copy
at a meeting).

Our collection remains incomplete. Below is a
list of missing newsletters. Anyone who lends us
one of these (or supplies a good clear copy) will
receive the next CD as our thanks.
1975: #2 and #3 (dates uncertain).
1976: January.
1984: August.
1985: June, July, August, September.
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